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Welcome to FLIGHTCHECK® COLLECT!
The term “collect” can be simply defined as the process of gathering
together a document and all of its related files, such as fonts and images,
so that the full job, with no missing elements, is complete and ready for
printing.All elements of the job must be available at the time of printing
in order to prevent the process from coming to a grinding halt, necessi-
tating a wait for the missing elements to be obtained.

Failing to fully collect a job can have serious consequences resulting
in wasted paper or film, lost time and consequently added expenses. For
example, if a document contains text which uses a particular font which
is inactive at the time of printing (because it was not included with the
job), the output device may use the screen version of the font, which
is usually bitmap and prints rather “blocky”, or even worse the printer
will substitute the font with another, most commonly the dreaded font
“Courier”. If an image is missing, an application may still go ahead and
output the picture using the low-resolution preview which you see on
the screen, with the end result being a poor or undesirable printout.

Now, imagine, if you will, the embarrassing experience of going to the
food store, taking your basket full of groceries up to the counter only to
discover you have left your money and credit cards back at home! Well,
a similar type of thing can happen to you as you try to get a job printed.
You must always first prepare your job, to ensure everything is complete
and ready. But, relax and do not worry for now you can rely on FlightCheck
Collect! to round up all your files for you before you go to press and
never again will you ever have to worry about the possibility of “leaving
something behind”.
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Life Before FlightCheck Collect!
Before FlightCheck Collect!, the most common way to prepare a job was
known as the “trial and error” approach.This is where you would print
the document, cheerfully skip over to your printer, pick up the paper,
then abruptly burst into tears after spotting something wrong.You would
then have to go back and find the missing items, and try printing again,
this time with fingers crossed.

As users started getting wiser, they would try to develop some sort of
checklist of items comprising the job. But, it isn’t always an easy thing to
know about all the fonts and images used within a document, let alone finding
the files on your hard drives.This process tended to be very time consuming,
and there was no guarantee of a complete and thorough job every time. If
just one single item was missing, it would need to be found and the document
would need to be reprinted.

Today we now have FlightCheck Collect! which scans documents electronically
with high precision and speed and discovers all of the elements required to
collect a complete job.

When FlightCheck Collect! issues its final approval, the job can then
be confidently sent along to be printed. But, the real advantage to using
FlightCheck Collect! becomes clearly evident when you consider what
might happen if you blindly and bravely attempt to print your document
without even bothering to first check if all the job is fully prepared and
that all items comprising the job have been gathered.

Therefore, before you go to press, you should always remind yourself of
this very important motto:“What you collect is what you get!”
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Installing FlightCheck Collect!

System Requirements
To use FlightCheck Collect!, you will need the following hardware:

• A Macintosh computer with either a 68K or PPC processor.

• A minimum of 2 to 4 MBs of RAM.

• Apple System software version 7.5 or higher.

• 13” RGB monitor.

Installation Procedure
To install FlightCheck Collect!, simply double-click the FlightCheck Collect!
Installer icon on your master diskette and choose the destination for the station
where you will be using your FlightCheck Collect!.

Memory Configuration
FlightCheck Collect!only requires about 2 MBs of RAM to operate
suffciently upon average to medium size jobs. However, if you want to
check very large files, or use a Fonts Database (page 16) which references
a large quantity of fonts, you will need to increase memory.

To increase the amount of memory allocated to FlightCheck Collect!,
click once on the FlightCheck Collect! application icon, then select
“Get Info...” from the Finder’s File menu.The Get Info window will
appear, displaying a variety of information about the application. In the
lower right corner of the window is the Memory Requirements area.
This lists the Suggested, Minimum and Preferred memory settings.

Enter a new value for the Preferred size. 8 MBs is usually plenty to run
FlightCheck Collect! on fairly large jobs.

Serial Number
Upon initally launching FlightCheck Collect!
you will be asked to enter your serial number.
You can find the serial number on the back
of the diskette or on the registration card.

Please take the time to fill out the registration card and return it for a
special FlightCheck T-shirt! Remember, only officially registered users
are eligible for free Tech Support and update notifications.
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FlightCheck Collect! Preferences
When you first launch FlightCheck Collect!, a folder will be created
within your System->Preferences folder called “FLIGHTCHECK®

COLLECT! Prefs ƒ”. This folder will contain your FLIGHTCHECK®

COLLECT! Preferences file as well as the Fonts Database file (see page
16).The Preferences file holds various setup parameters, such as the
positions of windows, your current sets of Ground Controls (see page 24),
and so forth.You may trash the FLIGHTCHECK® COLLECT! Preferences
file or the Fonts Database file at any time prior to running FlightCheck
Collect! and a new FLIGHTCHECK® COLLECT! Preferences file or Fonts
Database file will be automatically created.

Setting A Password
FlightCheck Collect! allows you to set your own password in order to
prevent others from running your copy of FlightCheck Collect!, effec-
tively stopping them from changing your particular setup or preferences
settings.You can set a password by selecting “Set Password...” from the
Edit menu.

To create a password, click the Set
Password button. If a password
already exists, first enter the pass-
word before clicking the button.

Enter your password (up to 8 char-
acters) and click OK upon which
you will be asked to retype your
password for verification.

Thereafter, whenever you run FlightCheck Collect! you will be asked to
enter your password in order to continue.
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FlightChecking a Document

Selecting a Document
Locate the document you
wish to flightcheck and
collect by first selecting
“Open Document...”
from the File menu.

You can choose which
file types to view by
selecting the desired
checkboxes. Detailed
information about the
currently selected file

will be displayed on the left, such as its file type and version number,
the file’s creation and last modified dates and the file’s size on disk.The
document’s page size will be presented on the right side of the window,
as well as a preview of the document (if one exists).When ready, click
the “Open” button or double-click the document’s title on the list.

Note that you can check multiple documents by dragging their icons (or
the folder they reside in) onto the FlightCheck Collect! application icon
and they will be examined individually one by one. (If drag & drop does
not work properly for you, then you will need to rebuild your desktop).

Recent Files
Upon opening a document, its name will be conveniently placed on the
“Recent Files” pop-up menu under the File menu.This allows you to
examine the file at any time in the future by simply selecting it from the menu.
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FlightCheck Collect! Tip:
Use the Find... button to
search the current volume in

order to locate a document by name.

FlightCheck Collect! Tip:
Holding down the control
key while clicking a check-

box will automatically deselect all
other checkboxes.

FlightCheck Collect! Tip:
To remove an item from
the menu, select it while

holding down the shift key.



Scanning a Document
When a document has been selected and
opened, FlightCheck Collect! will then begin
scanning the file by examining its elements
and building lists of data, such as the colors,
fonts and images used by the document and
placed artwork.While this is occurring, a win-
dow will appear informing you of the progress.

You can abort the process at any time by pressing command+“.” (period).

Examining a Document
FlightCheck Collect! will perform an extensive examination of the doc-
ument and all its elements. It will look at each page of the document and
examine all of the boxes and objects and record the various attributes and
parameters regarding each box, such as its position on the page, its back-
ground fill color, its frame color and thickness, and so forth. FlightCheck
Collect! will also scan the text characters of each story and record their
font and style usage, then determine the locations of the font suitcases and
printer font files and further scan these files to obtain additional detailed
information about each font used. FlightCheck Collect! will likewise
investigate each of the source image files by locating their links, opening
the image files and scanning through their internal data to obtain more
information about each image, such as its resolution, color mode, and so
on.Additionally, FlightCheck Collect! will begin gathering other impor-
tant information about the document such as its printer settings, trapping
defaults, style sheets and typographical preferences, etc. FlightCheck Collect!
will even conduct further research if it detects and determines the docu-
ment has related, possibly even required files, such as XTensions, Preferences,
Libraries, Dictionaries, PPDs, etc.

Verifying a Document
Once the document has been fully examined, a verification process will
begin.The gathered data is compared to a set of user-definable rules (known
as the “Ground Controls”) which allows you to instruct FlightCheck
Collect! to determine what exactly constitutes a passing or failing grade.
Finally, when all of the tests have been completed, FlightCheck Collect!
will display a Results window and present to you a comprehensive and
detailed report of the analysis.
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FlightCheck Collect! Results

Results Window

After FlightCheck Collect! has scanned the document, the Results window
will appear.

At the top of the Results window are the eight basic categories for which
FlightCheck Collect! will report.A green “√” checkmark means the category
appears to be OK while a red “X” means the category did not pass the
tests.The specific pass or fail status of each category depends, of course,
upon the current Ground Controls settings, as explained later.

Flagged Items
The Results window will display a list of flagged items, in other words
potential problems. Single-click a line and additional helpful infomation
about the item will be displayed at the very bottom of the window.

Specific Items
Click any arrow on the left side of the Results window to open an item
(or simply double-click the row) to reveal the specific elements involved.

Select the “Show All Specific Items” checkbox to reveal or hide all items
(or hold down the option key while clicking an arrow).
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Possible Remedies
To the right of each item on the Results list will be displayed a possible
remedy for the potential problem.These simple solutions can often be used
to help you quickly figure out how to correct the problem.

Print Results
You can print the Results (when the Results window is frontmost) by
selecting “Print Results...” from the File menu at which time you can
choose to include the Remedies, as well as the type of font you want for the
printout.

Save Results
You can save the Results to a text file, allowing you to import the text
file into an editor, by selecting “Save Results...” from the File menu.

Sound Alert
When checking is complete and FlightCheck Collect! has detected some
sort of problem, an “eagle cry” alert will sound.This can be turned off
by selecting “Turn Off Sound Alert” under the FlightCheck® menu.

8

FLIGHTCHECK COLLECT!

FlightCheck Collect! Tip:
You can find the FlightCheck
Fonts menu for OS 8 under

the General popup menu.

Secret Tip: Hold down the
control key while selecting “Sound
Alert” to choose a sound file.
Use the command key to revert
to the eagle cry.



FlightCheck Collect! Main Window

Main Window
The FlightCheck Collect! Main window contains three category buttons

which you can
use to reveal all
the details of the
current document.

Application Link Button

The Application Link button will display the name and version number
of the application which created the document. If the application location
is unknown, as evidenced by the Application Link button data being displayed
in red, or a red “X” appears to the left of the button, then FlightCheck
Collect! will be unable to employ certain advanced functions.

Selecting the Application

The first step you will need to take is to locate and select the application
that created the document.This is done by either single-clicking the
Application Link button, or by selecting “Locate Application...” from
the FlightCheck® menu.

FlightCheck Collect! will display a list of all possible applications that might
have created the document. Select the appropriate application version by
clicking once on its name to highlight it, then click the “Select” button.
FlightCheck Collect! will then be able to update the display of the
Application Link button on the Main window.

9

FLIGHTCHECK COLLECT! MAIN WINDOW

FlightCheck Collect! Tip:
Double-click the eagle icon at
the upper left corner to per-

form a full FlightCheck at any time.

FlightCheck Collect! Tip:
Hold down the control key
when using the Application

Link feature to avoid searching
Network volumes.



Applications Locations
As you work with various types of documents, FlightCheck Collect! will
remember the locations of your major applications such as QuarkXPress,
PageMaker, FreeHand, Photoshop, Illustrator, etc., and will automatically
select them for you whenever you open a document created by one of them.

It is important to keep in mind that the application version you used to
create a document should be the same as the one you intend to use to
print the document. For this reason, if you are going to a Service Bureau,
it is always advised you own a copy of the same application they will be
using, otherwise the output may not be quite what you expect. However,
it is sometimes acceptable to use a different minor revision number of an
application (generally recognized as the second digit). For example, an
application version of 1.02 might be equivalent with regards to the printing
output to a version 1.01, whereas the application versions 1.0 and a 1.1
(their first digits differ) might be totally different with respect to the way text
is flowed, and the varying preferences for each version of the application might
also affect printing.

Launching the Document
Once an application
has been located, you
can thereafter launch it
at any time by single-
clicking the Application
Link button, or by

selecting “Launch Document...” from the FlightCheck® menu.

At this time you can also select the “Launch document” checkbox to
send along a request to the application to open the current document.

You may work on the current document inside its application as desired,
but keep in mind that any changes you make to the “live” document will
only be in memory and therefore FlightCheck Collect! will be incapable
of recognizing your changes to the document. However, once you save the
document and then return back to FlightCheckCollect!, the document
file will be rescanned in order to update all the data to the document’s
currently saved state.
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The 3 Category Buttons
You can click any one of the three category buttons
at any time to expand the window to reveal details
regarding the category.

Reclick the button to collapse the window and close up the category.

Resizing a List
You can resize the lists for the colors, fonts or images categories by dragging

the area’s grow box at the right side of the window.The entire window
can be resized by dragging the grow box at the window’s bottom right corner,
or by clicking the zoom box at the upper right corner, in which case all
categories will be automatically adjusted in size.
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FlightCheck Collect! Tip:
Hold down the control key
when clicking a button to

also close all other categories.
Include the option key to open or
close either the group of 3 buttons,
or include both the option and
command keys to open or close
all buttons.



Colors List
Click the Colors button to reveal the Colors Info section.

The Colors Info
area will display
a list of the colors
used in the doc-
ment or within
placed images.
FlightCheck

Collect! builds this list by examining the colors used for text characters,
the colors which have been applied to the background fills and frames
of boxes, the colors used for lines and paragraph rules, and the colors
referenced within placed images.

Color Type Icon

The first column on the left, under the Usage section, shows an icon
which informs you of the color’s basic type.

Icon Meaning

The 4 Process colors, Cyan, Magenta,Yellow and Black, will be
recognizably displayed using their respective colors.

The Process color icon means that during the printing, the
color’s CMYK values will be used and no separation plates can
be obtained based on this specific color.

The Spot color (green icon) means when printing separations
you can use this specific color for an additional plate.

The Registration icon signifies the special registration color
which is most often intended to be used to print registration
marks and targets which will appear on all plates.

@@@@@@@@@
@@e?W@@@
@@?@@@Y@@
@@?@@@X@@
@@e?B@@@
@@?)X?3@@
@@?@)XN@@
@@?@@)X@@
@@@@@@@@@
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Used in Document Icon

The second column document icon informs you whether or
not the color is being used in the document.When this icon
appears in this column, it tells you that the specific color is used
somewhere in the document in a text story, as a background fill,
in a blend or gradient, or for a frame or line or paragraph rule.

Used in Image Icon

The third column image icon informs you whether or not the
color is being used in an image. In EPSF images, the color usually
pertains to a painted or stroked object making up the drawing, and
is often listed as a Spot color. A detailed TIFF image, which can
have millions of colors, is most often determined to consist of
mixtures of the 4 process colors: Cyan, Magenta,Yellow and Black.

Color Name and Sample

To the left of each color’s name is a sample display of the color.
Note that an underlined name indicates the color is a Spot color,
an italicized name indicates the Spot color is unused and an oouutt--
lliinnee name indicates a mismatch (the color values defined in the
application are different than the values in a placed EPSF).

Color Model, CMYK Values

To the right of the color’s
name are columns giving
you the color model and

the actual CMYK values for the color.Values displayed in their respective CMYK

colors indicate the color is a Process color while values displayed in black
indicate the color is a Spot color.A red value means the color is involved in
some sort of “mismatch” (the color is defined differently within an image).
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FlightCheck Collect! Tip:
Click and hold the button
on the image icon to view

a menu of the images using the
color. Select an item to likewise
select the image on the Images list.



Fonts List
Click the Fonts button to reveal the Fonts Info section.

The Fonts area
will display a
list of the fonts
used in the doc-
ument or by
placed images.
Any item which
appears in red

means FlightCheck Collect! has determined some sort of problem exists
based on the Grounds Controls.

Font Status Icons
The 5 columns under the Status section will display various icons
informing you of the status and usage of each font.

Icon Meaning

The System icon informs you that the font is currently active
A red icon indicates the font is inactive or cannot be located.

The fonts database icon means the font is not currently active,
but can be found in the Fonts Database.

The embedded font icon means the font resides inside the
EPSF, Postscript or PDF file being checked.

The font file icon represents the suitcase file in which the font
resides.A red icon indicates the suitcase file cannot be found.

The printer font file icon represents the font’s printer file.
A red icon indicates the printer file cannot be found. A “-” dash
character means a printer font will not be required for printing
(TrueType™ fonts).

The document icon means the font is used in a text story
somewhere within the document.

The image icon means the font is referenced in an EPSF image.

@@@@@@6Xe
@?f@)X?
@?@6KC@@1?
@?@S@@U?@?
@?@(MI/X@?
@?@HeS@@?
@?@??@0Y@?
@?g@?
@@@@@@@@@?

?O26K?e
@@@@@@e
@?e@@e
@?@@@@@@
@?@?W@?@
@@@?7@?@
@?@@?@
@@@@@0
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FlightCheck Collect! Tip:
Command-click a font on
the Fonts List to go to the

Fonts Database.



Font Name
This column will display the name of the font. If a name is displayed
in red then this indicates FlightCheck Collect! has detected some sort
of problem regarding this font in general.

Printer Font Filename
This column will display the printer font filename.A “-” dash character
means a printer font will not be required for printing (TrueType™ fonts).
A red name means the file cannot be located. Printing a document when
a printer font file is missing will usually result in a completely unwanted or
unexpected printout as the font will most likely be substituted (commonly
with the dreaded font “Courier”).

Font Style
The Style column will inform you if a style has been applied to the font.
Some fonts have built-in styled versions, which usually print just fine,
but in other cases where the font has no equivalent style, FlightCheck
Collect! will consider the usage of such a typeface to be an “error”.

Use Fonts Database

The Use Fonts Database checkbox instructs
FlightCheck Collect! to look into the Fonts Database for a font whenever it
appears to be missing or is not currently active at the time of the examination.
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Fonts Database
FlightCheck Collect! offers a very valuable feature called the “Fonts
Database”.To view the Fonts Database, select the item from the
FlightCheck® menu, or press command+D.

The Fonts Database is basically a list of the source folders where you would
like FlightCheck Collect! to look in order to find missing fonts,which thereby
allows FlightCheck Collect! to examine and verify fonts, as well as collect
them, even if the fonts are not active.

Fonts Folders
The Fonts Database works by allowing you to inform FlightCheck Collect!
of the locations of the various folders containing your font files.A Fonts
Folder can be added to the list by clicking the “Add Folder” button and
a window will appear asking you to select the desired folder.At this time
you may also direct FlightCheck Collect! to include all nested folders
contained within the chosen parent folder.

Screen Fonts
On the left portion of the Fonts Database window will be the list of screen
fonts which consists of the names of the font as you would see them if you
were inside your application working on the document. An underlined name
indicates the font is currently active.
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FlightCheck Collect! Tip:
You can type in a partial
name for a screen font in

order to find and select it on the list.

FlightCheck Collect! Tip:
Use the “Allow loose
Printer Fonts” checkbox to

search all font folders for missing
printer files (a feature of Suitcase).
Note that this may slow down the
Fonts Database.



Font Suitcases
When you click on a screen font name, its associated Font Suitcase on the
right portion of the screen will likewise become highlighted.

On the right side of the window will be a list of the Font Suitcase files in
which the fonts reside on disk. Click on the arrow to the left of a suitcase name

to “open” the suitcase and
reveal the fonts, along with
the names of their respective
styles and printer font files.

To remove a suitcase (provided it contains no active fonts), select it on
the list and click on the Remove Suitcase button.

Style
This column will display the respective style for the given font. It is
important to note that if a particular style (plain, bold, italic or bold+italic)
is not listed, then this means the font cannot support the style.

Printer Font Files
When a font suitcase item is “open” and its contents are revealed, the font’s
printer file name will also be displayed.A red icon indicates the file
cannot be found, while a “-” dash will mean the printer font file will not
be required for printing (for TrueType™ fonts).

Active Fonts
The Active Fonts radio button allows you to display a list of the fonts which
are currently active in your System.

All Fonts
The All Fonts radio button can be selected to view a list of all fonts
contained in your Fonts Database.
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FlightCheck Collect! Tip:
Option-clicking the twist
down triangle will open

or close all suitcases.

FlightCheck Collect! Tip:
You can tell if a font sup-
ports a particular style

by examining the suitcase in the
Fonts Database. If the style is not
listed, or the printer font file is
displayed in red, then you will
know there could be problems
printing the style.



Images List
Click the Images button to reveal the Images Info section.

The Images Info
area will display a
list of the images
used in the docu-
ment. FlightCheck
Collect! will locate
the link to each
source image file
and scan its inter-

nal data or characteristics to obtain the detailed information to display on
the Images list.

Image Usage Icons
The icons at the left of the Images list will represent the “usage” of the
images within the document, including whether or not an image has been
scaled, skewed or rotated, or if the box it resides in has been scaled, skewed
or rotated, or if some “style” or colorization has been applied to the image.
Icons which appear in red mean FlightCheck Collect! has determined
some sort of problem exists with the image usage based upon the related
Ground Controls settings.

Icon Meaning

The image icon will be displayed based on the known application
which created the image.

The font icon will represent the fact that the EPSF image is ref-
erencing one or more fonts.A red icon will indicate that FlightCheck
Collect! has also detected something wrong with at least one of
the fonts involved.
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FlightCheck Collect! Tip:
Click and hold down the
button on the image icon

to view a menu of the colors used
by the image. Select an item to
likewise select the color on the
Colors list.



Image Name 

The image name will be displayed under the Name column.Additional
characters or marks may appear next to the name.

Mark Meaning

The image contains other embedded images. Click the arrow to
reveal them.

+ The image is stored within the document or within another image.

- The image is not included in the document, but is merely
referenced by pathname.

The image is down-sampled FPO (For Position Only).

The image is hi-resolution OPI.

Page
The Page column will display the page number on which the image can
be found in the document.An “*” asterisk indicates the page number is the
start of a renumbering or Section Format.A “‡” character preceding the
page number indicates the image is positioned entirely off the page. For
PageMaker documents,“†PB” will signify the image is on the pasteboard
area of the document.

Status
The Status column will display the status of the image file:

Status Meaning
OK Image file exists and appears to be okay.
Missing Image file cannot be found.
Modified Image file has been changed (last saved date is different).
Off Page Image is outside the printable area.
Non-Print Image is suppressed from printing.
Stored Image is embedded in the document file.
Nested Image is embedded within another image.
LZW Image is LZW encoded.
JPEG Image is JPEG encoded
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FlightCheck Collect! Tip:
Click on the word “Name”
to toggle showing the

images using their full pathname.

FlightCheck Collect! Tip:
Click on the word “Page”
to toggle showing the page

numbers in Section Format “*”.



Size
The Size column will display the image’s physical file size (which will also
be used later on to estimate the disk space required to Collect the image).

Type
The Type column will display one of the following image types:

Type Description
PICT 72 dpi Macintosh picture
TIFF Tagged Image File Format
EPSF Encapsulated Postscript File (vector drawing)
EPS Encapsulated Postscript (pixel based image)
DCS/DCS2 Desktop Color Separations
CT Scitex Continuous Tone
LINE Scitex Line Work
JPEG Joint Photographic Experts Group (compressed)
PDF Acrobat® Portable Document File

Mode
The Mode column will display the image mode using one of the following:

Type Description
1-BIT Black and white
MONO Monotone
DUO Duotone
TRI Tritone
QUAD Quadtone
GRAY Grayscale
INDEX Indexed (1 byte index into an RGB color table)
RGB 3 bytes: Red, Green, Blue
CMYK 4 bytes: Cyan, Magenta,Yellow, Black
LAB Lab Color
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FlightCheck Collect! Tip:
Click and hold down the
button on the “font” icon

to view a menu of the fonts used
by the image. Select an item to
likewise select the font on the
Fonts list.

FlightCheck Collect! Tip:
A number after the mode
indicates the image contains

extra channels. An underlined
mode indicates the image is com-
prised of layers.

FlightCheck Collect! Tip:
An underlined size value
means the image has

been compressed (such as LZW
or JPEG).

FlightCheck Collect! Tip:

The icon indicates
the image is an IBM PC

type image.
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DPI
The DPI column will display the resolution of the image in terms of dots
per inch. Note that you can click on the “DPI” column header to toggle
viewing image resolutions by DPC (dots per centimeter).An EPSF (vector-
based) image will show “n/a” (not applicable) for its DPI because by
nature an EPSF is comprised of PostScript drawing commands which can
be acceptably printed within any spatial area or output resolution.
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FlightCheck Collect! Tip:
Click on the word “DPI”
to toggle showing the

resolution using DPI (dots per
inch) or DPC (dots per centimeter).



FlightCheck Collect! Report

Printing a Report
After a document has been scanned and the Main window is active,
Select “Print Report...” from the File menu and the Report preferences
window will appear.

Choose the items
you would like
to include in your
report by checking
the appropriate
boxes.

Upon clicking the Print button,you can then choose to print in color (problem
items will print in red),as well as choose the font for the Report.

Saving a Report
To save the Report to a text file, which allows you to then import the
text file into an editor, select “Save Report...” from the File menu.
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FlightCheck Collect! Tip:
Select the “Station Name”
checkbox to include your

computer’s Chooser name in the
Report.

FlightCheck Collect! Tip:
With FlightCheck Main
Window Active, select

“Print Report”; press Print button
to obtain printer dialog box. Hold
down the “General” popup, then
select “FLIGHTCHECK.” Check the
“Print Color” button to print
report in color.



FlightCheck Collect! Help
There are two types of help in FlightCheck Collect!: FlightCheck®

Collect! Help and General Help.

Select “FlightCheck® Collect! Help...” from the Help menu.The Help
window is sorted by topic and you can click through each section on the
left to find the help you need.

To obtain Hot Help for the Main window or the Ground Controls window
press command+? (or select “General Help...” from the Help menu) and
a special help cursor will appear. Move the help cursor over an item and
a special Help message window for that item will be displayed explaining
the item.To abort , simply click the mouse button.

FlightCheck Collect! Time
Hold down the shift key while clicking the Main
window’s title to obtain the amount of time spent
checking the current document.

Main Window & Ground Controls Title
Hold down the control key while clicking the Main window’s title to
include the name of the current Ground Controls set.
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FlightCheck Collect! Tip:
Click and hold down the
mouse button on any

item of the Main window or the
Ground Controls window to
obtain the Hot Help.



Ground Controls
The very heart of FlightCheck Collect! is based upon a powerful feature
called the “Ground Controls”.These are custom preferences that serve as the
rules for how FlightCheck Collect! should conduct its examination and
determine exactly what constitutes an “error”.You can instruct FlightCheck
Collect! to report on specific items from several different categories, allowing
you to expand your document checking possibilities as you desire.

Ground Controls Categories
The Ground Controls are divided into 3 general categories which allows
you to sweep through the flightchecking process section by section. Select
“Show Ground Controls” from the FlightCheck® menu, or press com-
mand+G, and the Ground Controls window will appear. Click on any of
the category buttons to expand the window into that category.

Reclick the category button to
collapse the window.

Click the expansion arrow on the right side of the window to view the
sub-sections of the category, or reclick to collapse the category.

Controls Lock

At the upper left corner is the Controls Lock. When this icon is
shown in the “locked” state, it means you cannot change any settings.

To unlock or relock the Controls, simply click on the icon.
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FlightCheck Collect! Tip:
Clicking a button with the
control key held down will

position the window at the bot-
tom of the screen.



Selecting a Control

To select or deselect a control, simply click on the checkbox.

Icon Meaning

An unchecked box informs FlightCheck Collect! to ignore this item.

A checked box means you are instructing FlightCheck Collect! to
use this item during its investigations.

A black framed unchecked box means the item was found to be used
by the document and could therefore be a possible item you might
want to eventually verify. Simply check the box to do so.A good
preflighter should always visually inspect the Ground Controls for
these framed boxes.

A red framed checked box will signify some sort of problem exists.
Uncheck this box to inform FlightCheck Collect! to assume the item
in question is no longer a “problem”.

The Default Set
FlightCheck Collect! always keeps an internal set called the “Default” set.
It is important to note that all Ground Controls sets (or file sets) share this
Default set and for this reason it is recommended you always create your
own custom sets to achieve more flexibility.

Ground Controls Sets
You can create your own customized sets of Ground Controls by selecting
“New Set…” from the pop-up menu and entering a name.

The currently selected
set will have a check-
mark next to its name
on the menu.

Selecting a Set
To activate a particular set, simply select it from the
menu. FlightCheck Collect! will then re-examine
the document and report its findings based upon
the new settings.

25

GROUND CONTROLS

FlightCheck Collect! Tip:
In order to save to a Ground
Controls file you first have

to create a new set.

FlightCheck Collect! Tip:
Changes made to your
Ground Controls settings

are always automatically saved
when you close the Ground
Controls window.

FlightCheck Collect! Tip:
You can undo any changes
made to the current set by

simply reselecting it from the menu.



Rename Set
Select this item in order to change the name of the current Ground
Controls set.

Delete Set
Select this item in order to remove the current set. Note that if you
delete the “Default” set, FlightCheck Collect! will revert to its standard
built-in settings.

Ground Controls Files
Ground Controls files are a saved group of Ground Controls sets.These
files can be given to your Service Bureau in order to communicate to
them the particular preferences which were used to check the job.

Loading Ground Controls
Use this item to locate and load a previously saved Ground Controls file.

Saving Ground Controls
Select this item (which will only be active when a non-Default set is cur-
rently selected) to save the current group of Ground Controls sets to a file.

Ground Controls Password
Select this item to set or change the password for the currently loaded
Ground Controls file.The password controls access to the controls lock, as
well as the rename and delete commands. Note that a password applies to
all sets of the current Ground Controls, not just the current set.

Printing Ground Controls
Simply select “Print Ground Controls…” from the FlightCheck® menu.

Ground Controls Window Title
Click the Ground Controls window’s title while holding down the control
key to toggle showing the actual name of the current set.

The Ground Controls set name will
likewise be appended to the Main

window if it has also been set (control-click) for displaying the full titles.
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Application-Specific Ground Controls
You can select which Ground Controls set to use whenever you open a
specific file type.The proper way to do this is by first creating a new set
and then saving the Ground Controls to a file.Then, open a document
and select “Set Application Controls...” from the FlightCheck® menu,
or click on the gray application button on the Ground Controls window.

Next, select the application’s button.

When an application specific set
has been chosen, the application’s
icon will then appear on the
Ground Controls window.

Thereafter, whenever you open a
document created by this application,

the designated Ground Controls set will be automatically employed to
perform the checking, thus eliminating the need to manual switch Ground
Control sets whenever you are checking various types of documents.
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FlightCheck Collect! Tip:
Choose “No Auto-Controls”
to deselect the set from

automatically being used.



Color Controls
The Colors category offers you additional ways to
ensure that the colors used in your documents and its

placed images are desirable.

Usage Controls
Check the Non-CMYK/Pantone®

box for FlightCheck Collect! to alert you
when the color model for any color is
neither CMYK nor a Pantone.You will
probably want to avoid colors which have
been defined using some other model,
such as RGB, or colors which do not
have corresponding inks available.

Check the Bitmap Frames box to be alerted when any box is using a custom
Bitmap Frame or Border. Bitmap frames and borders usually print at low
quality and should instead be created using actual PostScript commands or
by using an EPSF image.

Check the Mismatched Colors box to be alerted when the CMYK values
of a color referenced in an EPSF image do not match the CMYK values
of a similarly named color specified within the document or application’s
color palette.

Check the Hairlines box to be alerted when hairlines (frames, lines or
paragraph rules) are being used in the document. FlightCheck Collect!
defines a hairline as any linewidth less than .25 of one point.
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Font Controls
The Fonts category offers you a way to ensure that the
fonts used in your document are desirable, and is divided

into Status,Type and Usage controls.

Status Controls
Check the Active box for FlightCheck
Collect! to alert you when any font the
document is using is not currently active
in your System.

Check the Screen Font box to be alerted when any Screen Font the
document is using cannot be located, meaning the font is neither active
in the System nor can FlightCheck Collect! find the named font in the
Fonts Database.

Check the Printer Font box for FlightCheck Collect! to alert you when
any Printer Font file cannot be located.A missing printer font file will
always force the printer to substitute the font with some default font
(usually Courier). Note that not all fonts require a companion printer font
file and some fonts (such as TrueType®) have built-in printer instructions
on how to draw the characters.

Type Controls
Check the TrueType™ box for
FlightCheck Collect! to alert you when
any font is of the type TrueType. Some
output devices are incapable of handling
TrueType fonts, and furthermore it is

a generally accepted fact that mixing fonts on a page (using Type 1 and
TrueType) can cause some unexpected output problems.

Check the City/System Font box for FlightCheck Collect! to alert you
when any font has a name that is associated with a city, such as Chicago,
Geneva, Monaco, Charcoal, etc.The reason for this is that most “city” or
System fonts are usually merely bitmap fonts and always print at a fairly
low quality, thus they should be avoided.

Check the Multiple Masters box for FlightCheck Collect! to alert you
when any font is of the type Multiple Masters.
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Usage Controls
Check the Menu Styled box for
FlightCheck Collect! to alert you when
any font has been stylized via the appli-
cation’s Style menu and the font contains
no equivalent built-in style.This problem

exists rather frequently. For example, if you select some text and choose
“Bold” from the Style menu, but the font itself is incapable of printing in
boldface, then even though the text appears bold on the screen, it will be
printed as plain text on paper.Additionally, if the font can indeed support
the style, its companion printer font file must also exist in order to achieve
the desired style during printing.Therefore, FlightCheck Collect! will
warn you if either the font cannot support the style, or the printer font
cannot be found.
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Image Controls
The Images category offers you a way to ensure that
the images placed in your document are desirable and

can be acceptably printed, and is divided into Type, Mode and File Status.

Type Controls
Check the desired picture Type boxes
for FlightCheck Collect! to alert you
when any image is of that type. For
example, if you do not want to use any
JPEG encoded images, then you should
check the JPEG box.The item “Other”
represents any other image type which
is not listed.

Mode Controls
Check the desired picture Mode boxes
for which you want to be alerted. For
example, if you do not want any RGB

images, then check the RGB box.

File Status Controls
Check the Missing box for FlightCheck
Collect! to alert you when any image
file is missing.This obvious problem
often results in the application sending
the low-resolution preview of the image
to the printer if the original source file
containing the high-resolution data
cannot be located.

Check the Modified box to be alerted when any image file’s last modified
date does not match the date of the link data saved within the document.
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Check the Stored box for FlightCheck Collect! to alert you when an
image is embedded within your document file. In the case of a PageMaker
document or an EPSF image which contains an image, the embedded
image clearly aids in guaranteeing the document can be printed, seeing
how the image cannot possibly be considered “missing”. However, new
problems could arise if for some reason the Service Bureau needs to edit
the image, they may have a difficult time extracting the image out of the
document file.

Check the Not Included box in order to have FlightCheck Collect!
alert you when an EPSF file contains only a pathname reference to
another image. For example, while inside an application such as Illustrator
you can place an image and when saving the document as an EPSF you
can elect to “not include” the placed image.This is acceptable for Illustrator,
but if you then place the EPSF on a QuarkXPress document page, you
will not be able to print the image because the printing device will know
nothing about the file system or how to locate the additional image.

Check the Nested box for FlightCheck Collect! to alert you when an
EPSF image contains another image. Similar to the “stored” function,
this is not always considered a real problem, other than it is sometimes
impossible to be able to extract and edit the embedded image, but the
potential problems do in fact exist.This is compounded by the fact that
when an image within an image gets into multiple layers (called “plys”),
processing time increases, and in extreme cases can cause the output
device to bog down or run out of memory (similar to problems encoun-
tered when “grouping” too many objects).
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Collecting the Job

Collect Job
“Collecting” means to gather up all of the files related to a particular job,
including the font files, images and the document file itself, and copying these
files into a single job folder. FlightCheck Collect! allows you to collect all
elements in a job to prepare the job for output or further production work.

Select “Collect Job...” from the Collect menu, or press command+J,
and the Collect Job window will appear.

Collecting Fonts
The fonts list at the bottom left side of the window will show the status of
each font (which will be the same as the icons displayed on the Main window).
To set a font to be collected, click in the screen font column and a
checkmark will denote the font has been chosen.

To select the printer font file, click in the printer font column.

Note that a red font name will indicate the font file is missing.

Styles Menu / Point Size Menu
You can select either “All Styles” from the Styles pop-up menu to include
the styles found within the font, or “Used Styles” to collect just the specific
styles used within the text of the document.
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FlightCheck Collect! Tip:
To select or deselect all

fonts, click on the 
icon or icon column header.
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You can similarly select “All” from the Point Size pop-up menu to
include sizes of the font, or you can choose a single size of 9, 10 or 12.
Selecting the Used Style and single point size can often reduce the size
of the final collected job. However, always check with your Service
Bureau to learn exactly how they would like to accept your font files.

Fonts Folder
If you wish to collect the fonts into a separate fonts folder, select the
Fonts Folder checkbox.

Single Suitcase
If you wish to merge all fonts into a single suitcase file, check the Single
Suitcase box.The resulting suitcase file will be conveniently entitled
“documentname.fonts”.

Collecting Images
The images list at the bottom right side of the window will show the
status of each image.To set an image to be collected, click in the 
image column and a checkmark will denote the image has been chosen.

Note that a red image name indicates the file is missing.

Selecting Image Types
You can conveniently deselect all images by single-
clicking the image column header icon. Clicking
the icon a second time will reselect all images.

You can also obtain additional selective control by
holding down the mouse button on the image col-
umn header icon in which case a pop-up menu will
appear allowing you to choose the specific types of
images you would like to collect.

Note that an underlined image type on the pop-up
menu indicates the particular image type is in fact used
within the document.
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FlightCheck Collect! Tip:
To select or deselect all

images, click on the 
image icon column header.



Full Image Pathnames
Click on the Images column header “Name” in order to display the list
of images using their full pathnames.

Images Folder
If you wish to collect the images into a separate images folder, select the
Images Folder checkbox. However, you should be warned that when
you later open the document within its application then the “links” to
the images will have become broken, in which case you will need to update
their locations from this folder.

Collecting Ground Controls
Select the Ground Controls checkbox in order to include the current
Ground Controls file with your job. Note that the resulting file will have
its password removed, and each set will be conveniently locked (although
sets can be easily unlocked).The reason for this is so that you can safely
pass along your Ground Controls file to a print shop or Service Bureau
without having to give them your secret password.

Include Files
You may want to include additional files related to your document by
checking the desired items in the Include Files area of the Collect window.
You should, of course, select at least the Document checkbox to include the
actual document file in the collected job. For QuarkXPress documents, you
may want to check the XPress Prefs, Required XTensions box (when enabled)
and Dictionary boxes to include them in your collected job.

Misc. Files
Check the Misc. Files box in order to collect any additional files you
would like to include.A window allowing you to locate and create a list
of extra files will then be offered when the collection process begins.

Job Information
At the top right on the Collect window is the Job Info, including the
total number of files selected and the estimated accumulated file size of
the job (before compression) which you can then compare to the Space
Available value over at the top left side of the window (a red value will
indicate insufficient disk space).
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Compress Job
Check the Compress Job and Self-Extracting boxes as desired in order
to compress all of the files of the job into a single compacted file.You may
also choose to save the job as BinHex or to Segment to multiple disks.

Retain Job Name
Select the Retain Job Name checkbox in order to save the current title
for the job.This allows you to merge multiple jobs into this same job folder
during subsequent collections.

Creating a Job Folder
When all of the selections for your job
have been made, type in a name for the
job folder, locate the desired destination
on your drive, then click the Collect
button. If a folder already exists for the
job, you will be prompted in order to
continue with the collection.

Select the Use existing folder button to merge the current job into the
folder or use the Auto-rename new folder button to create a new folder.

Final Job Folder
The resulting job folder will display a special FlightCheck Collect! seal
of approval icon if the collection has passed inspection, or a failure icon if
there was some problem with collecting the entire job.

Pass Folder Fail Folder
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FlightCheck Collect! Tip:
If you do not see the folder’s
special job status icon, you

may need to rebuild your desktop
by re-booting and holding down
the command and option keys.

FlightCheck Collect! Tip:
If you deselect Retain Job
Name, you can recover the

original name by rechecking the
box, then control-clicking the box.



Collect Report
To create a text report of all the elements comprising the job, select
“Collect Report...” from the Collect menu. Similar to the Collect for
Output Report within QuarkXPress, the resulting text file can then be
placed within a word processor or editor.

You can choose to include in your report
information regarding specific categories of
elements by checking the appropriate boxes.

Navigate to the location where you want
to save the file, enter a title for the Report,
then click the Save button.

Stuff / Unstuff
You can also compress files by selecting “Stuff…” from the Collect menu.

Select a file and click the Add button to add the file to the Files List.To
removea file, select it on the Files
List and click the Remove button.

You can choose to make the resulting
compressed file Self-Extracting, or a
BinHex file (suitable for e-mailing), by
selecting the appropriate checkboxes.

To decompress a previously stuffed
file, select “Unstuff...” from the
Collect menu.

Segment / Join
To individually compress large files you can select “Segment…” from the
Collect menu. Choose the type of disk (or enter a default disk size) from
the Size of Segments pop-up menu, locate the archive, then press the
Segment button and follow the directions for inserting disks.

To join a previously segmented file, select “Join...” from the Collect menu,
locate the archives and follow the directions for inserting the disks.
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FlightScript™

FlightCheck Collect! provides several scripting functions which you can
access via AppleScript®.While the subject of scripting itself is beyond the
scope of this manual, the examples given below can be used to build
your scripts:

Scripting Functions
The list of possible scripting commands are as follows:

COMMAND RESULT

flightcheck “file name” FlightCheck named file

get color list returns a list of colors

get font list returns a list of fonts

get image list returns a list of images by full pathname

get image names list returns a list of images

load “controls name” loads named Ground Controls file

select set “set name” selects named Ground Controls set

get ground controls title returns name of Ground Controls

do full flightcheck recheck file

get flightcheck results returns the list of results

print results prints the results

show specific items opens specific items

show general items closes specific items

print report prints a FlightCheck report

save report saves a FlightCheck report

save report “report name” saves a FlightCheck report to file name

collect report saves a collect report 

collect report “report name” save a collect report to file name

collect job collects the job

collect job “job name” collects job to folder name

get document title returns document name

get application info returns application info

get file info returns file info
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get page info returns page info

get page setup info returns page setup info

get printer info returns printer info

get trap info returns trap info

Scripting a Workflow
You can use the following list of AppleScript commands which you can
send to FlightCheck Collect! in order to create a workflow that can
automatically check documents and obtain the results.

Note that lines beginning with “–” dashes are commented out. Simply
remove the dashes at your discretion before running the script:

tell application “FlightCheck Collect!”

–activate

with timeout of 120 seconds --IN CASE OF LARGE FILE

--flightcheck “my drive:my folder:my document file”

--end timeout

–GET A FILE VIA AN OPEN DIALOG:

–set theFile to choose file

–flightcheck theFile

–load “my drive:my folder:my ground controls file”

–select set “my set”

–do full flightcheck

–get flightcheck results

–print report

–save report

–save report “my report”

–collect report

–collect report “my report”

–collect job

–collect job “my job”

–quit application “FlightCheck Collect!” saving no

end tell
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